# Table of Contents

<table>
<thead>
<tr>
<th>Page</th>
<th>Section</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>Working With the New Features</td>
</tr>
<tr>
<td></td>
<td>Introduction</td>
</tr>
<tr>
<td>4</td>
<td>About the Nuendo Expansion Kit</td>
</tr>
<tr>
<td></td>
<td>Tempo Detection</td>
</tr>
<tr>
<td>7</td>
<td>Adjusting the Audio to the Project Tempo</td>
</tr>
<tr>
<td>8</td>
<td>About Time Stretch and Pitch Shift Algorithms</td>
</tr>
<tr>
<td>11</td>
<td>About Group Editing</td>
</tr>
<tr>
<td>11</td>
<td>Working With Lanes</td>
</tr>
<tr>
<td>15</td>
<td>Audio Editing Improvements</td>
</tr>
<tr>
<td>16</td>
<td>Video Improvements</td>
</tr>
<tr>
<td>17</td>
<td>VST Amp Rack</td>
</tr>
<tr>
<td>22</td>
<td>HALion Sonic SE (Nuendo Expansion Kit only)</td>
</tr>
<tr>
<td>22</td>
<td>LoopMash (Nuendo Expansion Kit only)</td>
</tr>
<tr>
<td>34</td>
<td>Quantizing MIDI and Audio</td>
</tr>
<tr>
<td>34</td>
<td>Introduction</td>
</tr>
<tr>
<td>34</td>
<td>Quantizing Audio Event Starts</td>
</tr>
<tr>
<td>34</td>
<td>AudioWarp Quantize</td>
</tr>
<tr>
<td>35</td>
<td>Quantizing MIDI Event Starts</td>
</tr>
<tr>
<td>35</td>
<td>Quantizing MIDI Event Lengths</td>
</tr>
<tr>
<td>35</td>
<td>Quantizing MIDI Event Ends</td>
</tr>
<tr>
<td>35</td>
<td>Quantizing Multiple Audio Tracks</td>
</tr>
<tr>
<td>36</td>
<td>AudioWarp Quantizing Multiple Audio Tracks</td>
</tr>
<tr>
<td>36</td>
<td>The Quantize Panel</td>
</tr>
<tr>
<td>42</td>
<td>Additional Quantizing Functions</td>
</tr>
</tbody>
</table>
Introduction

This document describes in detail the features that have been added or changed since the release of Nuendo 5.0.

The chapter “Quantizing MIDI and Audio” has been revised and is therefore included in its entirety.

About the Nuendo Expansion Kit

The Nuendo Expansion Kit adds a number of music composition functions from Steinberg’s Cubase (the “Cubase Music Tools”) to the standard Nuendo application. The Nuendo Expansion Kit (NEK) is a separate product and can be purchased through your Steinberg dealer.

Whenever procedures in this manual use functions available only when the NEK is installed, this is indicated in the text by “Nuendo Expansion Kit only”.

Tempo Detection

Nuendo offers a powerful tempo detection algorithm that can be used on any rhythmic musical content, even if it has not been recorded to a metronome click and/or contains tempo drift. This feature serves two main purposes:

- Analyzing the tempo of freely recorded audio so that other (audio or MIDI) tracks can follow this tempo.
- Adjusting freely recorded audio to the project tempo, which can be fixed or variable.

Audio Requirements

- The audio event has to be at least 7 seconds long.
- Musical Mode has to be deactivated for the clip.
- The track has to be set to linear timebase (this happens automatically).
- The audio material needs to have discernible beats.
The Tempo Detection Panel

The Tempo Detection Panel contains the functions for analyzing the tempo of an audio event. It is opened via the Project menu.

In the top section of the panel, the name of the selected audio event is shown. Below the name, the Analyze button is located. Click this button to start the tempo detection for an event.

The middle section contains several functions for correcting and fine-tuning the detected tempo curve. These functions are described in the section “Correcting and Fine-Tuning the Detected Tempo Map” on page 6.

The arrow buttons at the bottom right let you change the direction in which the algorithm will analyze the audio material during a manual correction operation. To work backwards, i.e. to reanalyze the beginning of the tempo curve, activate the left arrow button (see “The Beginning Of The Tempo Curve Needs To Be Corrected” on page 7).

With the Reset button at the bottom left you can delete the complete analysis data and start again from scratch.

- Any tempo events beyond the event timeline will also be removed upon reset.
- The Tempo Detection Panel has to be opened specifically for the event that you want to analyze. To analyze another event, close the panel, select the event, and reopen the panel.

Detecting the Basic Tempo of an Audio Event

1. In the Project window, select the audio event that you want to analyze.
3. Click the Analyze button.

The following happens:

- A rough tempo map based on the beat analysis is created for the selected audio clip.
- A tempo and a signature track are added to the project.
- The project will get a 1/4 signature, because the tempo detection only calculates a tempo based on beats, regardless of a musical signature. The signature can be modified later.
- The Time Warp Tool is selected for fine-tuning or adjusting the newly generated tempo map.

Depending on the rhythmic quality of the source material, the tempo analysis may directly lead to a perfect result. However, if this is not the case, you can apply the correction and fine-tuning functions. To find out whether such actions are necessary, activate the metronome click and play back the project.
Correcting and Fine-Tuning the Detected Tempo Map

If the metronome click does not match the audio perfectly, perform any of the following operations, depending on the situation.

**The Detected Tempo Is Too Fast Or Too Slow**

- To double or halve the detected tempo, use the “Multiply by 2” and “Divide by 2” buttons.
- To adjust the detected tempo with a factor of 3/4 or 4/3, use the “Multiply by 4/3” and “Multiply by 3/4” buttons.

Examples:
- If your audio is twice as fast as the detected tempo, you can apply the “Multiply by 2” function.
- If your audio contains dotted notes or triplets and the algorithm detects 3 beats where 4 are expected, you can apply the 4/3 conversion.
- If the actual signature is 2/4 and the algorithm detected 6/8 beats or vice versa, you can apply a 3/4 conversion combined with the “Multiply by 2” function.

**The Detected Tempo Has Jumps And Spikes Although It Should Be Steady**

If you get the message that the algorithm has detected irregular tempo changes, even though you know that the material has a more or less steady tempo, you can use the “Smooth Tempo” function.

- To retrigger the tempo analysis based on the assumption that the event has a steady tempo, click the “Smooth Tempo” button.
  Irregular spikes or tempo changes are removed during this analysis.

**The Detected Tempo Is Off By Half A Beat**

In some cases, the offbeat of a rhythm might be dominant enough to confuse the beat detection algorithm resulting in an offset. In that case it is necessary to shift the tempo events.

- To shift the detected tempo events by half a beat, click the “Offbeat Correction” button.

**The Tempo Was Not Detected Properly For The Whole Event**

Sometimes it is impossible for the algorithm to properly detect the tempo for the whole audio event because the audio contains sections played in a different tempo or has special rhythmic characteristics. Manual adjustments are then necessary to create a perfect tempo track.

To manually correct tempo events, proceed as follows:

1. With the Tempo Detection Panel still open, play the track from the beginning and listen to the click.
   It is useful to zoom in on the waveform so that the transients are visible. Using the stationary cursor could be useful as well.
2. Locate the first tempo event that is off. Use the Time Warp Tool to move this tempo event to the correct position.
   The material to the right of the corrected event will be reanalyzed and the tempo recalculated.
3. Continue listening to the audio until you reach the next misplaced tempo event and repeat the manual correction procedure until you reach the end of the song.
The Beginning Of The Tempo Curve Needs To Be Corrected

When you edit a tempo event, the tempo curve by default is reanalyzed from the point of editing towards the right. However, if the detection did not produce proper results at the beginning of the event, you can change the direction in which the algorithm works.

Proceed as follows:
1. At the bottom of the Tempo Detection Panel, activate the left arrow button to change the direction of reanalysis.
2. Locate the first correct tempo event at the beginning of the audio and use the Time Warp tool to move the corresponding tempo event slightly back and forth to trigger a backwards detection.

The tempo at the beginning of the audio event is corrected and new events are added where necessary.

The Audio Material Contains Sections With Different Tempos

In some cases, a track may include multiple sections with different tempo and the tempo detection might stop at the position of a tempo change or pause in the audio.

If the manual adjustment of individual tempo events does not give you satisfying results for files with varying tempo, you can cut the audio event at each major tempo change and perform the tempo detection for each of the resulting sections independently.

Remember that each cut needs to have a length of at least 7 seconds.

Finishing

Once the tempo map is correct, close the Tempo Detection Panel. You can now set up signature events with the correct time signature.

Adjusting the Audio to the Project Tempo

If you want freely recorded audio to follow a fixed tempo or a different project tempo, you can use the Set Definition From Tempo dialog to save the tempo information from the tempo track in the corresponding audio clips.

Proceed as follows:
1. Select the audio events that you want to have follow the project tempo.
   For example, this could be the individual tracks in a multi-track drum session.
2. On the Audio menu, open the Advanced submenu and select the “Set Definition From Tempo...” option.

The Set Definition From Tempo dialog opens.
3. Select whether you want to save the tempo information in the project file only or in the selected audio clips. Writing the definition into the audio files allows you to use these in other projects, complete with tempo information.

4. Select if you want to set all tracks to musical timebase. If you do not activate this option, only the tracks containing the selected events are set to musical timebase.

5. Click OK. The tempo information is now copied into the selected audio clips and the tracks are set to musical timebase. Furthermore, Musical Mode is activated for the audio events.

⚠️ If you have placed audio events referring to the same audio clip at different positions on the timeline and you apply the “Set Definition From Tempo” function simultaneously to these events, new audio files are written for all the events except the first.

The audio tracks will now follow any tempo changes in the project. Therefore, you can disable the tempo track and set a fixed tempo for your project or edit the tempo track for a new tempo map. Warping is applied to the events to match the tempo. By default, the “élastique Pro Time” time shifting algorithm is applied, which should lead to the best-quality results.

About Time Stretch and Pitch Shift Algorithms

In Nuendo, time stretching and pitch shifting algorithms are used for numerous operations (e.g. the Time Stretch and Pitch Shift offline processes, in the Sample Editor, or by the Flatten function). Depending on the feature, some or all of the following algorithm presets are available.

élastique

The élastique algorithm is suited for both polyphonic and monophonic material. The algorithm has three modes, and there are three presets for each mode. The following modes are available:

- élastique Pro – This mode offers the best audio quality, without formant preservation.
- élastique Pro Formant – This is the same as the Pro mode, but including formant preservation.
- élastique efficient – This mode requires less computing powers, but has a lower audio quality than the Pro modes.

These modes are available with the following variants:

- Time – Timing accuracy is favored over pitch accuracy.
- Pitch – Pitch accuracy is favored over timing accuracy.
- Tape – The pitch shift is locked to the time stretch (as when playing back a tape with varying speed). Stretching the audio material to a longer duration automatically decreases its pitch. This variant has no effect when used in combination with event transpose or the transpose track.
### MPEX

MPEX is an alternative high-quality algorithm. You can choose between the following quality settings:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MPEX – Preview Quality</td>
<td>Use this mode only for preview purposes.</td>
</tr>
<tr>
<td>MPEX – Mix Fast</td>
<td>This mode is a very fast mode for preview. This works best with composite music signals (mono or stereo material).</td>
</tr>
<tr>
<td>MPEX – Solo Fast</td>
<td>Use this mode for single instruments (monophonic material) and voice.</td>
</tr>
<tr>
<td>MPEX – Solo Musical</td>
<td>Same as above but higher quality.</td>
</tr>
<tr>
<td>MPEX – Poly Fast</td>
<td>Use this for processing monophonic and polyphonic material. This is the fastest setting that gives still very good results. You can use this for drum loops, mixes, chords.</td>
</tr>
<tr>
<td>MPEX – Poly Musical</td>
<td>Use this for processing monophonic and polyphonic material. This is the recommended MPEX default quality setting. You can use this for drum loops, mixes, chords.</td>
</tr>
<tr>
<td>MPEX – Poly Complex</td>
<td>This high quality setting is quite CPU-intensive and should be used only when processing difficult material or for stretch factors above 1.3.</td>
</tr>
</tbody>
</table>

When applying the Pitch Shift process, you can choose between the regular setting and a setting where the formants are preserved for each quality setting.

### Standard

The Standard algorithm is optimized for CPU efficient realtime processing. The following presets are available:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standard – Drums</td>
<td>This mode is best for percussive sounds, because it does not change the timing of your audio. Using this option with certain tuned percussion instruments may lead to audible artifacts. In this case, try the Mix mode as an alternative.</td>
</tr>
<tr>
<td>Standard – Plucked</td>
<td>Use this mode for audio with transients and a relatively stable spectral sound character (e.g. plucked instruments).</td>
</tr>
<tr>
<td>Standard – Pads</td>
<td>Use this mode for pitched audio with slower rhythm and a stable spectral sound character. This minimizes sound artifacts, but the rhythmic accuracy is not preserved.</td>
</tr>
<tr>
<td>Standard – Vocals</td>
<td>This mode is suitable for slower signals with transients and a prominent tonal character (e.g. vocals).</td>
</tr>
<tr>
<td>Standard – Mix</td>
<td>This mode preserves the rhythm and minimizes the artifacts for pitched material that does not meet the above criteria (i.e. with a less homogenous sound character). This preset is selected by default for audio that is not categorized.</td>
</tr>
<tr>
<td>Standard – Custom</td>
<td>This preset allows you to manually tweak the time stretching parameters (see below). By default, the settings that are shown when you open the dialog are those of the last preset used (except if the Solo preset has been selected, see below).</td>
</tr>
</tbody>
</table>
If you select the “Standard – Custom” option, a dialog opens where you can manually adjust the three parameters that govern the sound quality of the time stretching:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Grain size</td>
<td>The standard time-stretching algorithm splits the audio into small pieces called “grains”. This parameter determines the size of the grains. For material with many transients, use low grain size values for best results.</td>
</tr>
<tr>
<td>Overlap</td>
<td>Overlap is the percentage of the whole grain that will overlap with other grains. Use higher values for material with a stable sound character.</td>
</tr>
<tr>
<td>Variance</td>
<td>Variance is also a percentage of the whole length of the grains, and sets a variation in positioning so that the overlapping area sounds smooth. A Variance setting of 0 will produce a sound akin to time stretching used in early samplers, whereas higher settings produce more (rhythmic) “smearing” effects but less audio artifacts.</td>
</tr>
</tbody>
</table>

Limitations

Applying time stretching or pitch shifting to audio material can lead to a degradation in audio quality and to audible artifacts. The result depends on many factors, such as the source material, the particular stretch and pitch operations applied, and the selected audio algorithm preset.

As a rule of thumb, smaller changes in pitch or duration cause less degradation. However, there are additional issues one should be aware of when working with time stretching and pitch shifting algorithms.

In rare cases, editing warped audio events may cause discontinuities at the edit points. You can then try to move the edit point to a different position or bounce the audio event prior to editing.

Reverse Playback and Scrubbing

Most of the algorithms used for time stretching and pitch shifting only support forward playback. Reverse playback or scrubbing of warped audio events can lead to recurring artifacts in the playback.

Pitch and Stretch Factor Limitations

Some algorithms may put limitations on the maximum degree of time stretching or pitch shifting supported. For the élastique presets, the maximum pitch shift factor is 4, and the stretch factor is limited to 10. In case your settings cause a higher factor, Nuendo displays a warning message and deactivates the algorithm for the affected events until the settings are changed to stay within the valid bounds.
About Group Editing

The Group Editing mode for folders allows you to quickly group events and parts across multiple tracks without having to select all the events or parts. This is useful for multi-track recordings of drum sets, where you often want to edit the different drum tracks (bass drum, snare, toms, etc.) together.

You activate the Group Editing mode by clicking the Group Editing button (the “=” sign) for a folder in the track list.

If you select an event or part in Group Editing mode, the selection is applied across all tracks inside the folder track. All events or parts that have the same start time, end time, and playback priority are selected and grouped. If you create a selection range in Group Editing mode, it is also applied across all tracks in the folder track.

Edit actions, such as resizing, affect all grouped events, parts, or selection ranges. You can also switch between takes for all the selected tracks simultaneously, which is useful for comping the tracks of a multi-track recording.

A grouping is automatically cancelled if you make a different selection or click in an empty area of the event display.

The Group Editing setting overwrites any regular group settings in the edit group. For further information, see the chapter “Working with Projects” in the Operation Manual.

Working With Lanes

To show the lanes for a track, click the corresponding “Show Lanes” button in the track list.

Lanes are handled differently for audio and MIDI.

- Audio
  Each audio track can only play back one single audio event at a time. Therefore, you only hear the take that is activated for playback.

- MIDI
  Overlapping MIDI takes can be played back simultaneously. There is no playback priority between lanes on a MIDI track.
Editing Operations

Soloing Lanes
You can solo individual lanes by activating the corresponding button in the track list. Only one lane can be soloed at a time.

Auditioning Takes on Lanes
Select the Object Selection tool, and [Ctrl]/[Command]-click on an audio event or a MIDI part. Playback starts from the position where you click.

Cutting Events or Parts on Lanes
- To cut single events or parts, select the Object Selection tool, and [Alt]/[Option]-click.
  If you cut a MIDI part and the cut position intersects one or several MIDI notes, the result depends on the “Split MIDI Events” option in the Preferences dialog (Editing–MIDI page).
- To cut all events or parts on all lanes, perform the cut on the main track.

Adjusting the Borders Between Takes
- To adjust the border between two takes on a lane, position the mouse pointer over the border and drag to the left or right.
  This way you can fine-tune your edits.
- To adjust the border between two takes on all lanes, drag the border on the main track.

Adjusting the Length of Takes
- Drag the resize handles of the takes to adjust their length.

Moving the Content within Takes
- To move the content of the selected audio event or MIDI part within its boundaries, hold down [Ctrl]/[Command]-[Alt]/[Option] and drag.
  This can be used to correct the timing of a take. However, this is not possible if the entire clip is contained in the event.

Selecting Events or Parts on Lanes
- To select an event or a part, click on it.
- To select several events or parts, hold down [Shift] and click, or draw a selection rectangle around the events or parts.

Activating Events or Parts on Lanes
When you move the mouse pointer over an event that overlaps another event, an additional smart spot becomes available in the middle of the lower border.
- For audio, this toggles between “to front” and “to back”.

12
Working With the New Features
Working With the New Features

Working With Lanes

- For MIDI, the corresponding part is muted/unmuted, without changes to the other parts.
  
  This allows you to edit multiple parts that sound at the same time, which is useful when working with drum recordings on different lanes, for example.

Range Selection Tool Operations

- To glue cuts, select a range that spans all the cuts that you want to glue, and double-click.
  
  The gluing affects all the lanes of a track.

Comping

When recording vocals or instrument performances, you often record the same material several times and then assemble the best parts of the recordings into a final take. This process is often referred to as comping. The recorded takes usually contain very similar material and have the same start and end positions.

Comping can be done in the Project window and in the Audio Part Editor. However, some functions are only available in the Project window.

- If you work with stacked events on an audio track and you mute an event, the result depends on the “Treat Muted Audio Events like Deleted” setting in the Preferences dialog (Editing–Audio page): When deactivated, the entire section is muted and you hear nothing. When activated, the event behind the muted event is played back. For comping operations, it is recommended to keep this option deactivated.

Assembling a perfect take

1. Select the Comp tool.

2. Listen to the recording and cut it into smaller sections.

3. Listen to the takes in the different sections and bring the best ones to the front.

4. Arrange and edit the material on your lanes until the takes are aligned the way you want them.

The Comp Tool

In comping, similar material on multiple lanes is modified together. Therefore, the Comp tool affects all events on all lanes simultaneously.

Activating and Deactivating

- Click on an event or a part on a lane.

  The behavior is slightly different for audio and MIDI:

  - For audio events this means “to front/to back”.
  - For MIDI parts, this means both to front/to back and mute/unmute.

  However, this only applies for parts that have the same start and end positions. The playback state for other parts, for example, for longer parts that play at the same time, is unchanged.

Selecting

- Hold down [Shift] and click on an event or a part.
Auditioning

- Press [Ctrl]/[Command] to activate the speaker tool and click on an audio event or a MIDI part. Playback starts from the position where you click.

Cutting

- To cut through events on all lanes, [Alt]/[Option]-click on an event on a lane or on the main track.

Adjusting the Borders

- To adjust the border for all events or parts that share this border, click on the border and drag.

Resizing

- To resize all events that have the same start and end positions, drag the resize handles on an event on a lane or on the main track.
  Resizing is constrained to the end or start of the adjacent events. This ensures that you do not create overlaps accidentally.

Range Editing (Project Window Only)

You can create a range by clicking and dragging on a lane in the Project window. When you release the mouse, the following happens:

- The events on all lanes are cut at the range borders.
- On the lane on which you clicked, the events that lie within the range are activated.
- If possible, events on lanes are merged within the range. For this to work, the audio events must be adjacent without gaps or fades, and the material itself must match.

  If you click and drag on the main track instead of a lane, the events are moved.

Final Steps

When you have finished working on lanes, there are several functions that you can use to finalize your work.

Deleting Overlaps (Audio Only)

You can remove the overlaps in a selection using the “Delete Overlaps” command on the Advanced submenu of the Audio menu. This command puts the active takes on a single lane and removes any takes found in the background.

Cleaning Up Lanes

This command cleans up overlaps between events by distributing them on new lanes, where necessary. If a track contains empty lanes, these are removed.

- Open the context menu for the track and select “Clean Up Lanes”.
Creating Tracks from Lanes
This command converts each lane into a new audio track. The created tracks are placed below each source track and are selected. All inactive events are muted.

- Open the track list context menu, and select “Create Tracks from Lanes”.
  If you open the context menu for the main track, new tracks are created for all its lanes. If you open the context menu for a lane, tracks are created for the selected lanes.

Bouncing MIDI
When you have edited the MIDI takes to your liking, you can create one single MIDI part from these takes.

- Select all the parts on the lanes in the Project window, open the MIDI menu and select “Bounce MIDI”.

Audio Editing Improvements

Audio Processing

When offline processing is applied to audio events, you can now extend the processed range beyond the event borders. This is done in the extended section of the audio processing dialog. When “Extend Process Range” is activated, you can specify which portions of audio to the left and right of the event borders are affected (provided that the event plays only a part of the audio clip, i.e. audio is available outside the event borders). For example, this allows you to enlarge the event even after applying the processing.

Note that this option works globally. When you activate it for one offline process, it stays activated for all further processing until you switch it off again.

- The extended section is shown by clicking the “More…” button.
- This only works if the entire audio event is selected (separately or as part of a selection range).
- When you try to process an event whose clip is also used by another event, a warning message appears. To apply the processing as specified (i.e. beyond the event borders), click “New Version”.

Working With the New Features
Audio Import

When creating split files from multi-channel files, you can now specify how the split files are named. This allows for compatibility with other products when exchanging audio files.

Select an option from the “Split File Name Format” pop-up menu, which can be found below the “Split multi-channel files” or “Split channels” options in the Preferences dialog (Editing–Audio page), the Import Options dialog, or the Export Audio Mixdown dialog. This allows you, for example, to add the suffix “_L” to the left channel and the suffix “_R” to the right channel.

![Import Options](image)

Sample Editor Improvements

Some editing improvements have been made to the Sample Editor. These are available when the AudioWarp tab is open and the Snap button is activated.

- If hitpoints are available, the Range Selection and Free-Warp tools snap to the hitpoint positions and/or warp tabs.
- The hitpoint positions are indicated with small triangles at the top of the waveform display.

Video Improvements

Sometimes, video problems, such as stutters during playback, are caused by the codec not supporting multi-threading. This can be the case for video files that use single-threaded decoding, such as Motion-JPEG, Photo-JPEG, and QuickTime DV. This kind of file is typically created when capturing video with Decklink/AJA cards.

To compensate for this, the Video Player page in the Device Setup dialog now contains the “Boost Video (Reduce Audio Performance)” option.

When this option is activated, one of the available CPU cores is excluded from audio processing and reserved for video tasks like decoding and playback. However, this may reduce the audio performance.

![Video Playback](image)

For this option to have an effect, the Multi Processing option must also be activated in the Device Setup dialog (VST Audio System page).
VST Amp Rack

The VST Amp Rack is a powerful guitar amp simulator. It offers a choice of amplifiers and speaker cabinets that can be combined with stomp box effects. The audio effect plug-in processes the mono sum of the channel and outputs a mono or stereo signal, depending on the track configuration.

At the top of the plug-in panel there are six buttons, arranged according to the position of the corresponding elements in the signal chain. These buttons open different pages in the Display section of the plug-in panel: Pre-Effects, Amplifiers, Cabinets, Post-Effects, Microphone Position, and Master.

Below the Display section, the selected amplifier is shown. The color and texture of the area below the amplifier indicate the selected cabinet.

Pre/Post-Effects

On the Pre-Effects and the Post-Effects pages, you can select up to six common guitar effects. On both pages the same effects are available, the only difference being the position in the signal chain (before and after the amplifier). On each page, every effect can be used once.

Each effect features an On/Off button known from stompbox effects, as well as individual parameters. The following effects and parameters are available:

<table>
<thead>
<tr>
<th>Effect</th>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Wah Wah</td>
<td>Pedal</td>
<td>Controls the filter frequency sweep.</td>
</tr>
<tr>
<td>Volume</td>
<td>Pedal</td>
<td>Controls the level of the signal passing through the effect.</td>
</tr>
<tr>
<td>Compressor</td>
<td>Intensity</td>
<td>Changes the intensity of the compressor effect.</td>
</tr>
<tr>
<td>Chorus</td>
<td>Rate</td>
<td>Allows you to set the sweep rate. This parameter can be synchronized to the project tempo, see “Sync Mode” on page 19.</td>
</tr>
<tr>
<td></td>
<td>Width</td>
<td>Determines the depth of the chorus effect. Higher settings produce a more pronounced effect.</td>
</tr>
<tr>
<td>Phaser</td>
<td>Rate</td>
<td>Allows you to set the sweep rate. This parameter can be synchronized to the project tempo, see “Sync Mode” on page 19.</td>
</tr>
<tr>
<td></td>
<td>Width</td>
<td>Determines the width of the modulation effect between higher and lower frequencies.</td>
</tr>
<tr>
<td>Flanger</td>
<td>Rate</td>
<td>Allows you to set the sweep rate. This parameter can be synchronized to the project tempo, see “Sync Mode” on page 19.</td>
</tr>
<tr>
<td>Effect</td>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------</td>
<td>---------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Feedback</td>
<td></td>
<td>Determines the character of the flanger effect. Higher settings produce a more “metallic” sounding sweep.</td>
</tr>
<tr>
<td>Mix</td>
<td></td>
<td>Sets the level balance between the dry and the wet signal.</td>
</tr>
<tr>
<td>Tremolo Rate</td>
<td></td>
<td>Allows you to set the modulation speed. This parameter can be synchronized to the project tempo, see “Sync Mode” on page 19.</td>
</tr>
<tr>
<td>Tremolo Depth</td>
<td></td>
<td>Governs the depth of the amplitude modulation.</td>
</tr>
<tr>
<td>Octaver Direct</td>
<td></td>
<td>Adjusts the mix of the original signal and the generated voices. A value of 0 means only the generated and transposed signal is heard. By raising this value, more of the original signal is heard.</td>
</tr>
<tr>
<td>Octave 1</td>
<td></td>
<td>Adjusts the level of the signal that is generated one octave below the original pitch. A setting of 0 means that the voice is muted.</td>
</tr>
<tr>
<td>Octave 2</td>
<td></td>
<td>Adjusts the level of the signal that is generated two octaves below the original pitch. A setting of 0 means that the voice is muted.</td>
</tr>
<tr>
<td>Delay Delay</td>
<td></td>
<td>Sets the delay time in milliseconds. This parameter can be synchronized to the project tempo, see “Sync Mode” on page 19.</td>
</tr>
<tr>
<td>Delay Feedback</td>
<td></td>
<td>Sets the number of repeats for the delay.</td>
</tr>
<tr>
<td>Delay Mix</td>
<td></td>
<td>Sets the level balance between the dry and the wet signal.</td>
</tr>
<tr>
<td>Tape Delay Delay</td>
<td></td>
<td>Tape Delay creates a delay effect known from tape machines. The Delay parameter sets the delay time in milliseconds. This parameter can be synchronized to the project tempo, see “Sync Mode” on page 19.</td>
</tr>
<tr>
<td>Tape Delay Feedback</td>
<td></td>
<td>Sets the number of repeats for the delay.</td>
</tr>
<tr>
<td>Tape Delay Mix</td>
<td></td>
<td>Sets the level balance between the dry and the wet signal.</td>
</tr>
<tr>
<td>Tape Ducking Delay Delay</td>
<td></td>
<td>Tape Ducking Delay creates a delay effect known from tape machines with a ducking parameter. The Delay parameter sets the delay time in milliseconds. This parameter can be synchronized to the project tempo, see “Sync Mode” on page 19.</td>
</tr>
<tr>
<td>Tape Ducking Delay Feedback</td>
<td></td>
<td>Sets the number of repeats for the delay.</td>
</tr>
<tr>
<td>Tape Ducking Delay Duck</td>
<td></td>
<td>Works like an automatic mix parameter. If the level of the input signal is high, the portion of the effect signal is lowered, i.e. ducked (low internal mix value). If the level of the input signal is low, the portion of the effect signal is raised (high internal mix value). This way the delayed guitar signal stays rather dry during loud or intensely played passages.</td>
</tr>
<tr>
<td>Overdrive Drive</td>
<td></td>
<td>Overdrive creates a tube-like overdrive effect. The higher the Drive value, the more harmonics are being added to the output signal of this effect.</td>
</tr>
<tr>
<td>Overdrive Tone</td>
<td></td>
<td>Works as a filter effect on the added harmonics.</td>
</tr>
<tr>
<td>Overdrive Level</td>
<td></td>
<td>Adjusts the output level.</td>
</tr>
</tbody>
</table>
Working With the New Features

VST Amp Rack

Sync Mode

For some controls, the sync mode can be activated to synchronize the corresponding parameter with the tempo of the host application. These plug-in parameters are then used to specify the base note value for tempo syncing (1/1 to 1/32, straight, triplet, or dotted).

The names of these parameters are underlined. Click on a control knob to activate/deactivate tempo sync. An LED at the top right of the knob indicates that Sync mode is active. You can then select a base note value for tempo syncing from the pop-up menu above the control.

Using Effects

- To insert a new effect, click the plus button that appears when hovering with the mouse over an empty plug-in slot or over one of the arrows before or after a used effect slot.
- To remove an effect from an effect slot, click on the effect name and select “None” from the pop-up menu.
- To change the order of the effects in the chain, click on an effect and drag it to another position.
- To activate or deactivate an effect, click on the pedal-like button below the effect’s name.
  When an effect is active, the LED next to the button is lit.

⚠️ Pre-effects are always mono, while post-effects can be mono or stereo, depending on the track configuration.

_using the Quick Controls in Nuendo, you can conveniently set up an external MIDI device such as a foot controller to control the VST Amp Rack effects. For more information, see the chapter “Track Quick Controls” in the Operation Manual._

<table>
<thead>
<tr>
<th>Effect</th>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fuzz</td>
<td>Boost</td>
<td>Fuzz creates a rather harsh distortion effect. The higher the Boost value, the more distortion is being created.</td>
</tr>
<tr>
<td></td>
<td>Tone</td>
<td>Works as a filter effect on the added harmonics.</td>
</tr>
<tr>
<td></td>
<td>Level</td>
<td>Adjusts the output level.</td>
</tr>
<tr>
<td>Gate</td>
<td>Threshold</td>
<td>Determines the level where Gate is activated. Signal levels above the set threshold trigger the gate to open, and signal levels below the set threshold close the gate.</td>
</tr>
<tr>
<td></td>
<td>Release</td>
<td>Sets the amount of time it takes for the gate to close.</td>
</tr>
<tr>
<td>Equalizer</td>
<td>Low</td>
<td>Changes the level of the low-frequency portion of the incoming signal (from -12 dB to 12 dB).</td>
</tr>
<tr>
<td></td>
<td>Middle</td>
<td>Changes the level of the mid-frequency portion of the incoming signal (from -12 dB to 12 dB).</td>
</tr>
<tr>
<td></td>
<td>High</td>
<td>Changes the level of the high-frequency portion of the incoming signal (from -12 dB to 12 dB).</td>
</tr>
<tr>
<td>Reverb</td>
<td>Type</td>
<td>A convolution-based reverb effect. The Type parameter allows you to switch between different reverb types (Studio, Hall, Plate, and Room).</td>
</tr>
<tr>
<td></td>
<td>Mix</td>
<td>Sets the level balance between the dry and the wet signal.</td>
</tr>
</tbody>
</table>

Fuzz
Boost
Fuzz creates a rather harsh distortion effect. The higher the Boost value, the more distortion is being created.

Tone
Works as a filter effect on the added harmonics.

Level
Adjusts the output level.

Gate
Threshold
Determines the level where Gate is activated. Signal levels above the set threshold trigger the gate to open, and signal levels below the set threshold close the gate.

Release
Sets the amount of time it takes for the gate to close.

Equalizer
Low
Changes the level of the low-frequency portion of the incoming signal (from -12 dB to 12 dB).

Middle
Changes the level of the mid-frequency portion of the incoming signal (from -12 dB to 12 dB).

High
Changes the level of the high-frequency portion of the incoming signal (from -12 dB to 12 dB).

Reverb
Type
A convolution-based reverb effect. The Type parameter allows you to switch between different reverb types (Studio, Hall, Plate, and Room).

Mix
Sets the level balance between the dry and the wet signal.
Amplifiers

The amps available on the Amplifiers page were modeled on real-life amplifiers. Each amp features settings typical for guitar recording, such as gain, equalizers, and master volume. The sound-related parameters (Bass, Middle, Treble, and Presence) have a significant impact on the overall character and sound of the corresponding amp.

The following amp models are available:
- Plexi – Classic British rock tone; extremely transparent sound, very responsive.
- Plexi Lead – British rock tone of the 70’s and 80’s.
- Diamond – The cutting edge hard rock and metal sounds of the 90’s.
- Blackface – Classic American clean tone.
- Tweed – Clean and crunchy tones; originally developed as a bass amp.
- Deluxe – American crunch sound coming from a rather small amp with a big tone.
- British Custom – Produces the sparkling clean or harmonically distorted rhythm sounds of the 60’s.

The different amps keep their settings when you switch models. However, if you want to use the same settings after reloading the plug-in, you need to set up a preset.

Using Amplifiers

- To switch amps on the Amplifiers page, simply click on the model that you want to use.
- Select “No Amplifier” if you only want to use the cabinets and effects.

Cabinets

The cabinets available on the Cabinets page simulate real-life combo boxes or speakers. For each amp, a corresponding cabinet type is available. However, you can combine amps and cabinets at will.

Using Cabinets

- To switch cabinets on the Cabinets page, simply click on the model that you want to use. Select “No Cabinet” if you only want to use the amps and effects.
- If you select “Link Amplifier & Cabinet Choice”, the plug-in automatically selects the cabinet corresponding to the selected amp model.

Microphone Position

On the Microphone Position page, you can choose between 7 positions to place the microphone. These positions result from two different angles (center and edge) and three different distances from the speaker, as well as an additional center position at an even greater distance from the speaker.

You can choose between two microphone types: a large-diaphragm condenser microphone and a dynamic microphone. Crossfading between the characteristics of the two microphones is also possible.

Placing the Microphone

- To select a microphone position, simply click on the corresponding ball in the graphic. The selected position is marked in red.
- To select one of the microphone types or blend between the two types, turn the Mix control between the two microphones.
**Master**

Use the Master page to fine-tune the sound. There is an additional three-band Equalizer, a Tuner, and a Master level control for the output of the plug-in.

**Using the Master Controls**

- To activate/deactivate the Equalizer, click the pedal-like On/Off button. When the Equalizer is active, the LED next to the button is lit.
- To activate/deactivate an equalizer band, click the corresponding Gain knob. When a band is active, the LED to the left of the Gain knob is lit.
- To tune your guitar strings, click the pedal-like On/Off button to activate the Tuner and play a string. When the correct pitch is displayed and the row of LEDs below the digital is green, the string is tuned correctly. The more red LEDs on the left/right are lit, the lower/higher the pitch.
- To mute the output signal of the plug-in, click the pedal-like Master button. When the LED is off, the output is muted. Use this to tune your guitar in silence, for example.
- To change the volume of the output signal, use the Level control in the Master section.

**View Settings**

Two different views for the VST Amp Rack plug-in panel are available: the default view and a compact view, which takes up less screen space.

In the default view, you can use the top buttons to open the corresponding page in the Display section above the amp controls. In the compact view, the page display is hidden from view. You can still change the amp settings and switch amps or cabinets using the mouse wheel.

- In the default view, you can horizontally resize the plug-in panel by clicking and dragging the edges or corners.

**Using the Hover Controls**

Hover controls are buttons that become visible on the plug-in frame if the mouse pointer is positioned somewhere on the plug-in panel.

**Switching Between Default and Compact View**

- To toggle between the different views, click the down/up arrow button (Show/Hide Extended Display) at the top center of the plug-in frame.

**Changing the Amplifier and Cabinet Selection in the Compact View**

In the compact view, a hover control on the lower border of the plug-in frame allows you to select different amplifier and cabinet models.

- To select a different amplifier or cabinet, click the name and select a different model from the pop-up menu.
To lock the amplifier and cabinet combination, activate the “Link/Unlink Amplifier & Cabinet Choice” button. If you now select another amp model, the cabinet selection follows. However, if you select a different cabinet model, the lock is deactivated.

Previewsing Effect Settings

In both views, you can show a preview of the pre- and post-effects that you selected on the corresponding pages:

- Click and hold the Show Pre-Effects or Show Post-Effects button at the bottom left or right (respectively) of the plug-in frame.

HALion Sonic SE (Nuendo Expansion Kit only)

The VST instrument HALion Sonic SE is described in a separate PDF document.

LoopMash (Nuendo Expansion Kit only)

This version of the Nuendo Expansion Kit comes with an updated version of the VST instrument LoopMash. LoopMash is one of a kind: a powerful tool for the slicing and instant re-assembling of any kind of rhythmic audio material. With LoopMash, you can preserve the rhythmic pattern of one audio loop, but you can replace all sounds of this loop with the sounds from up to seven other loops.

LoopMash provides dozens of possibilities to influence the way the slices are re-assembled, thus giving you full control over the results of your performance. You can choose from a variety of effects and apply them to single slices or to your overall performance. Finally, you can store your configuration as scenes on scene pads, and trigger these scene pads with your MIDI keyboard. All this turns LoopMash into a really powerful instrument for live performances and recordings!

LoopMash is fully integrated into Nuendo, which allows you to drag and drop audio loops from the MediaBay or Project window directly onto the LoopMash panel. Furthermore, you can drag and drop slices from LoopMash to the sample pads of Groove Agent One. This allows you to extract certain sounds that you like from...
LoopMash and use them with Groove Agent One. LoopMash supports the undo and redo functionality of Nuendo, so that you can see and modify your steps in the Edit History dialog, as long as the LoopMash panel is open.

Getting Started

To give you a first impression of what you can do with LoopMash, we have created a tutorial preset. Proceed as follows:

1. In Nuendo, create an instrument track with LoopMash as the associated VST instrument.

2. In the Inspector for the new track, click the Edit Instrument button to open the LoopMash panel.
   It has two main areas: the track section in the upper part of the panel, and the parameter section at the bottom.

3. At the top of the plug-in panel, click on the icon to the right of the preset field and select Load Preset from the pop-up menu.

4. The Presets browser opens, showing presets found in the VST 3 Presets folder for LoopMash.

5. Select the preset called “A Good Start…(Tutorial) 88”.
   The preset is loaded into LoopMash.

6. At the bottom of the panel, make sure that the sync button in the transport controls is off, and start playback by clicking the play button.

In the LoopMash panel, you can see a sliced loop waveform in the top (red) track. This track is selected (which is indicated by the track’s background color and the lit button to the left of the waveform display).

The selected track holds the master loop. The rhythmic pattern of the LoopMash output is governed by the master loop – i.e. what you hear is the rhythmic pattern of this loop.

7. Look at the 24 pads below the track section: the pad labeled “Original” is selected. Select the pad named “Clap”.
   A new loop is displayed on the second track in the track display, and you hear that the snare drum sound of the first loop has been replaced with a handclap sound.

8. Select the pad labeled “Trio”, and then the pad labeled “Section”. Each time you click, a new loop is added to the mash.
   Note how the rhythmic pattern of the music stays the same, although an increasing number of sounds is taken from the other loops.

9. Select other pads to find out how different parameter settings influence the LoopMash output. For a detailed description of the available parameters, see the section “LoopMash Parameters” on page 25.
   Some of the pads have the same label, e.g. “Original” and “Replaced”. The scenes that are associated with these pads form the basis for variations of that scene. The variations of a scene are associated with the scene pads to the right of the original scene, i.e., the scene labeled “SliceFX” is a variation of the scene labeled “Original” and shows an example for the usage of slice effects (see “Applying Slice Selection Modifiers and Slice Effects” on page 28).

On the left of each track, you find the similarity gain sliders. These sliders are the most important control elements of LoopMash: the further to the right you move the similarity gain slider of a track, the more slices will be played back from this track.
How Does LoopMash Work?

Whenever you import a loop into LoopMash, the plug-in analyzes the audio material. It generates so-called "perceptual descriptors" (information on tempo, rhythm, spectrum, timbre, etc.) and then slices the loop into eighth-note segments.

This means that after you have imported several loops, LoopMash knows the rhythmic pattern of each loop and the location of various sounds that make up this pattern within each loop. During playback, LoopMash uses the perceptual descriptors to determine how similar each slice is to the current slice of the master track.

Note that LoopMash does not categorize the sounds, but looks for overall similarity in the sound. For example, LoopMash might replace a low snare drum sound with a kick drum sound, even though a high snare sound is also available. LoopMash always tries to create a loop acoustically similar to the master loop, but using other sounds.

The similarity is shown by the brightness of each slice on each track, and also by the position of each slice on the similarity gain slider to the left of each track (when you click on a slice, its position is highlighted on the similarity gain slider). The brighter a slice, the more similar a slice is to the current master track slice, and the further to the right it is displayed on the similarity gain slider. Darker slices are less similar and can be found further to the left on the slider.

The similarity gain settings of the various tracks determine which slice gets playback priority. This creates a new loop, over and over again, but with the rhythmic pattern of the original master loop.

In the following figure you can see four tracks. The track at the top is the master track. During playback, LoopMash moves through the master loop step-by-step (which is indicated by a rectangle in the track’s color around the current slice) and automatically selects four slices from these tracks to replace the slices of the master track. The currently playing slice is indicated by a white rectangle around the slice.

The following figure shows the result of the selection process for each playback step.

Master track slices for playback steps 1 to 4.

Slices 1 to 4 selected for playback.

For best performance, use audio files that have the same sample rate as your project (to avoid sample rate conversion when loading presets or storing scenes).

Experiment with the provided LoopMash presets, and with your own loops of different lengths and with different rhythms, containing many different sounds – LoopMash is like an instrument, and we very much encourage you to play it!
LoopMash Parameters

You can influence the process of constantly assembling a new loop with the various functions and parameter controls of LoopMash.

Note that many of LoopMash's parameters can be automated. See the description for the automation of VST instrument parameters in the chapter “VST instruments and instrument tracks” in the Operation Manual.

The Track Section

The track section contains the track display with the track controls for setting the track volume and a transposition value to the right of each track. To the left of the track display you will find the similarity gain sliders. With the button between the similarity gain slider and the track, you can define the master track that serves as the reference for rhythm and timbre. At the top of the track display you will find a ruler that shows bars and beats and the loop range selector.

Importing and Removing Loops

You can import up to eight audio loops onto the eight tracks in the track display. Proceed as follows:

1. Locate the audio loop that you want to import in one of the following locations: MediaBay and the MediaBay related browsers (e.g. the Mini Browser), Project window, Pool, Sample Editor (regions), Audio Part Editor, or the Explorer/Finder. The quickest way to find the LoopMash content is to use the MediaBay: Navigate to the LoopMash content via the VST Sound node.

2. Drag the loop file onto a track in LoopMash. Dragging a loop to a track already occupied replaces the original loop.

LoopMash separates the loop into slices, analyzes them, and displays them as a waveform on the track. One track can hold up to 32 slices. Even if a long loop were to contain more than 32 slices, LoopMash imports only the first 32. Ideally, you would use a loop file cut at bar boundaries. When you import your file from the MediaBay, LoopMash uses the tempo information supplied by the MediaBay for the slicing of the loop.

- To remove a loop from a LoopMash track, right-click the track and select “Clear track”.

Defining the Master Loop

One track is always selected. This is the master track: it provides the rhythmic pattern that you hear, and it is the sounds of this loop that are replaced by slices selected from the other loops in the current LoopMash configuration.

- To make a track the master track, activate the button to the left of the track display.
Auditioning Slices
To audition the slices, proceed as follows:

- Click on the slice that you want to hear.
- Use the Step function in the transport controls (see “Transport Controls” on page 28) to step through the slices.

Playback and Master Slice Indicators
A rectangle in the track color around a slice indicates the current position within the master loop, i.e. the master slice. The slice currently selected for playback is indicated by a white rectangle.

Setting a Loop Range
At the top of the track display, a ruler showing bars and beats (using the project’s time signature) is displayed. In the ruler, you also find the loop range selector (the bracket) that defines the play length.

- To shorten the play length, click and drag the handles of the loop range selector (the bracket) at the top of the track display.
  This allows you to select even a very small range within your master loop for playback – the rest of the loop is not taken into consideration. Note that short loop ranges (less than 1 bar) may conflict with the jump interval setting (see “Storing Your Configuration as Scenes” on page 29).
- To change the playback range, click the loop range selector and drag it to a different position as a whole.

Setting Track Transposition Value and Track Volume
The track controls to the right of each track allow you to set a track transposition value and the track volume for each track individually.

- To set a track transposition value, click the button to the right of the track and select the transposition interval from the pop-up menu.
  The set value is displayed on the button.
  This function is tied to the setting for the Slice Timestretch parameter (see “Audio Parameters” on page 31). When Slice Timestretch is deactivated, transposition is created by increasing/decreasing the playback speed of the slices (transposing a track up by one octave corresponds to playing the slices twice as fast). With Slice Timestretch on, you get true pitch shifting, i.e., there is no change in playback speed.
- You can change the relative volumes of your tracks with the volume controls on the far right of each track.
  This is useful for level adjustments between tracks. A VU meter to the left of the volume control provides visual feedback of the current volume.

Setting the Similarity
With the similarity gain slider (to the left of each track) you can determine how important a particular track is for the “mashing up” of the master loop. By moving the slider, you specify that a track is more/less similar to the master track, thus “overruling” the result of the LoopMash analysis. As a result, more/less slices from this track are included in the current mash.

- Move the slider to the right to select more slices from the corresponding track for playback, and to the left to reduce the number of slices for playback (set to middle position by default).
  The brightness of the slices changes when moving the similarity gain slider. The further to the right, the lighter the color, and the higher the playback priority for these slices.
The vertical lines on the similarity gain slider correspond to the slices in this loop. The changing pattern of slices indicates similarity of each slice, on all tracks, to the current master track slice. The further to the right a line is, the greater the similarity of this slice to the master slice.

- Drag the similarity threshold control (the thin line with handles at the top and bottom intersecting all similarity gain sliders) to the left or right to determine a minimum similarity that slices must match to be considered for playback.
  Slices with a similarity below (i.e. to the left of) this threshold are not played.

On the Slice Selection page at the bottom of the LoopMash panel, you can make further settings for influencing which slices will be played (see “Slice Selection” on page 30).

Creating Composite Tracks

LoopMash allows you to build composite tracks, i.e., as soon as you drag a slice to a different position on the same track or another track, you will be asked if you want to create a composite track.

To build a composite track, proceed as follows:

1. Import the loop that you want to extract sounds from.

2. Audition the slices and drag the slices that you want to use onto an empty track.
   A dialog opens asking you to confirm that you want to create a composite track, and to determine the number of slices that the track will contain. If you enter a higher number of slices than the track actually contains, the track will be filled up with empty slices.

   ![Image](image.png)

   Move this slider to specify the number of slices that the track will include.

3. Click OK.
   The destination track of the dragged slice becomes composite, indicated by a “C” to the left of the track.

   ![Image](image.png)

   Composite track

   You can use this feature in a very versatile way:
   - You can assemble a combination of sounds that you like most on one track.
   - You can define a certain rhythmic pattern by combining slices from different loops on a composite track and making this track the master loop.
   - You can use a composite track as a clipboard, allowing you to include sounds from more than eight loops into your mash.
   - You can use one track for importing and removing the loops that you want to search for sounds, and use the remaining seven tracks as composite tracks. This allows for including up to 32 sounds from up to 32 different loop files on each of the seven composite tracks.

   Composite tracks are quantized according to the set tempo (see “Transport Controls” on page 28).
Applying Slice Selection Modifiers and Slice Effects

Right-clicking a slice opens a context menu where you can influence the selection of individual slices and which effect is applied to them. The upper part of the context menu shows the slice selection modifiers. The following options are available:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Always</td>
<td>Only available for master track slices. The slice is played always.</td>
</tr>
<tr>
<td>Always Solo</td>
<td>Only available for master track slices. The slice is played always and exclusively (independent of the Voices parameter that you set on the Slice Selection page, see “Slice Selection” on page 30).</td>
</tr>
<tr>
<td>Exclude</td>
<td>The slice is never selected for playback.</td>
</tr>
<tr>
<td>Boost</td>
<td>Increases the similarity for this particular slice, so that it is played back more often.</td>
</tr>
</tbody>
</table>

Below the selection modifiers, the context menu shows the slice effects. The following options are available:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mute</td>
<td>Mutes the slice.</td>
</tr>
<tr>
<td>Reverse</td>
<td>Plays the slice in reverse.</td>
</tr>
<tr>
<td>Staccato</td>
<td>Shortens the slice.</td>
</tr>
<tr>
<td>Scratch A, B</td>
<td>Plays the slice as if scratched.</td>
</tr>
<tr>
<td>Backspin 4</td>
<td>Simulates a turntable backspin lasting over 4 slices.</td>
</tr>
<tr>
<td>Slowdown</td>
<td>Applies a slowdown.</td>
</tr>
<tr>
<td>Tapestart</td>
<td>Simulates a tapestart, i.e., speeds the slice up.</td>
</tr>
<tr>
<td>Tapestop 1, 2</td>
<td>Simulates a tapestop, i.e., slows the slice down.</td>
</tr>
<tr>
<td>Slur 4</td>
<td>Stretches the slice over 4 slice lengths.</td>
</tr>
<tr>
<td>Slur 2</td>
<td>Stretches the slice over 2 slice lengths.</td>
</tr>
<tr>
<td>Stutter 2, 3, 4, 6, 8</td>
<td>Plays only the initial portion of a slice, and repeats it 2, 3, 4, 6, or 8 times during one slice length, respectively.</td>
</tr>
</tbody>
</table>

The best way to hear the results of the effects is to try them out!

You can also apply effects to your overall performance (see “Performance Controls” on page 32).

Transport Controls

The transport controls can be found at the bottom of the LoopMash panel.

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Play</td>
<td>Click the Play button to start or stop playback.</td>
</tr>
<tr>
<td>Locate</td>
<td>Click the Locate button to return to the beginning of the loop (bar 1/beat 1). Playback always starts automatically when clicking this button.</td>
</tr>
<tr>
<td>Step</td>
<td>Clicking the Step left/right button steps backwards/forwards through the timeline, playing one slice at a time.</td>
</tr>
</tbody>
</table>
Setting the LoopMash Tempo

During playback, LoopMash can be synchronized to the tempo set in Nuendo, or can follow its own tempo setting:

- Click the sync button (to the right of the Play button) to activate or deactivate synchronization to the project tempo set in Nuendo.
  
  When sync is on, you can start playback using the Nuendo transport controls. With sync off, LoopMash starts playing only when you click the Play button in LoopMash.

- When the sync button is deactivated, the current LoopMash tempo (in BPM) is displayed in the tempo field to the left of the master button. To change the "local" tempo, click in the tempo field, enter a new value, and press [Enter].

- When the sync button is deactivated, you can click the master button (to the right of the tempo field) to copy the tempo of the current master loop into the tempo field.

  The sync on/off parameter can be automated. This is useful to control LoopMash in a Nuendo project – with sync off, the playback of LoopMash within a project is paused.

Controlling Transport Functions With Your MIDI Keyboard

You can control the start, stop, sync on, and sync off function with your MIDI keyboard.

<table>
<thead>
<tr>
<th>Function</th>
<th>Key</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start</td>
<td>C2</td>
</tr>
<tr>
<td>Stop</td>
<td>D2</td>
</tr>
<tr>
<td>Sync on</td>
<td>E2</td>
</tr>
<tr>
<td>Sync off</td>
<td>F2</td>
</tr>
</tbody>
</table>

If you do not have a MIDI keyboard connected to your computer, you can make use of the Virtual Keyboard feature in Nuendo (see the Operation Manual).

Storing Your Configuration as Scenes

On the Slice Selection and the Audio Parameters pages you will find a row of 24 pads. To each of these pads, you can save one “scene”, i.e. a combination of up to eight tracks with all parameter settings. By triggering the pads, you can quickly change between different scenes during your performance.

- To save the current settings as a scene, click the round button and then a pad. This saves your setup to that pad.
- To recall a scene, click on the corresponding scene pad.
- To remove a scene from a pad, click the x button and then the pad.
- To edit a scene pad label, double-click on the scene pad and enter a name.
- To rearrange the scene pads, click on a scene pad and drag it to a new position.

Once you have set up a LoopMash configuration, you should save it to a scene pad. Changing scenes without saving means discarding any unsaved changes.
Setting a Jump Interval

You can determine a point at which LoopMash changes to the next scene during playback when you trigger a pad. Proceed as follows:

- Click the Jump interval button and select an option from the pop-up menu that opens.

ภา The option “e: End” means that the current loop is played to the end before switching scenes. When you set up a short loop range, you may need to set the interval to “e: End” to ensure that the jump point is reached.

Triggering Scene Pads With Your MIDI Keyboard

As you can see, the scene pads are arranged according to the keys on a MIDI keyboard. You can trigger the 24 scene pads with a connected MIDI keyboard starting from C0 and ending with B1. You can also make use of the Virtual Keyboard for triggering the scene pads (see the Operation Manual).

Slice Selection

Click the Slice Selection button (above the transport controls) to open the Slice Selection page. The options on this page allow you to further influence which slices will be selected for playback.

The following parameters are available:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of Voices</td>
<td>Here you can set the total number of slices from all tracks that are used to replace the master slice (according to the current similarity gain settings). The range is from one (left) to four (right) voices, i.e. sounds from up to four loops can play simultaneously. Increasing the number of voices increases the CPU load.</td>
</tr>
<tr>
<td>Voices per Track</td>
<td>This is the maximum number of slices that can be selected from a single track. The range is from one to four. The less slices can be picked from the same track, the more variety you get in the LoopMash output.</td>
</tr>
<tr>
<td>Selection Offset</td>
<td>Move this slider to the right to allow slices that are less similar to be selected for playback. This setting affects all tracks of this scene (see “Storing Your Configuration as Scenes” on page 29).</td>
</tr>
<tr>
<td>Random Selection</td>
<td>Move this slider to the right to allow more variation when selecting slices for playback, adding a more “random” feel to the selection process. This setting affects all tracks of this scene (see “Storing Your Configuration as Scenes” on page 29).</td>
</tr>
<tr>
<td>Selection Grid</td>
<td>Here you can determine how often LoopMash will look for similar slices during playback: always (left position), or only every 2nd, 4th, or 8th (right position) step. For example, if you set the Selection Grid to every 8th step (right position), LoopMash will replace similar slices every 8th step. Between two “replacement” steps it plays back the tracks of the slices that have been selected in the last replacement step, resulting in longer playback sequences on one track.</td>
</tr>
</tbody>
</table>
LoopMash (Nuendo Expansion Kit only)

Audio Parameters

Click the Audio Parameters button (above the transport controls) to open the Audio Parameters page. With the options on this page you can influence the sound of the LoopMash audio output.

The following parameters are available:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adapt Mode</td>
<td>With Adapt Mode, you can adapt the sound of the selected slice to the sound of the master slice. The available options are: Volume – changes the overall volume of the selected slice. Envelope – modifies volume changes within the slice. Spectrum – modifies the spectrum of the slice (equalization). Env + Spectrum – this is a combination of the Envelope and Spectrum modes.</td>
</tr>
<tr>
<td>Adapt Amount</td>
<td>Move this slider to the right to increase the adaptation specified with the Adapt Mode parameter.</td>
</tr>
<tr>
<td>Slice Quantize</td>
<td>Move this slider to the right to apply quantizing to the slices, i.e. the slices are aligned to a eighth-note grid. When the slider is all the way to the left, the slices follow the rhythmic pattern defined by the original master loop.</td>
</tr>
<tr>
<td>Slice Timestretch</td>
<td>Use this option to apply realtime timestretching to the slices, filling gaps or avoiding overlaps between slices that are not played back at their original tempo, or when combining slices with different original tempos. Applying timestretch increases the CPU load and may affect the sound quality. Reduce the need for timestretching by using loops with similar original tempos. See also the description of the track transposition value (see “Setting Track Transposition Value and Track Volume” on page 26).</td>
</tr>
</tbody>
</table>

Parameter Similarity Method

Here you can modify the criteria that LoopMash considers when comparing the slices for similarity. There are three similarity methods:

Standard – This is the standard method, where all slices on all tracks are compared and various characteristics regarding rhythm, tempo, spectrum, etc. are taken into account.

Relative – This method does not only consider the overall similarity of all slices on all tracks, but also takes the relation to the other slices on the same track into account, e.g., LoopMash may replace the loudest, lowest sound on one track with the loudest, lowest sound on another track.

Harmonic – This method only takes the analyzed tonal information into account, so that a slice is replaced by a harmonically similar slice, rather than by a rhythmically similar slice. With this method, also the track transposition value is considered, i.e., a master slice with a C major chord will not be replaced by a slice with a D major chord. But it will indeed be replaced if you set the transposition value of the track of the slice with the D major chord to “-2”. It is advisable to keep the similarity gain sliders in a low position when you work with this method, because otherwise you may produce disharmonies. You can modify the transposition values to play back more slices of a specific track.
Working With the New Features

LoopMash (Nuendo Expansion Kit only)

Performance Controls

Click the Performance Controls button to open the Performance Controls page. On this page you find a row of buttons that are arranged according to the keys on a MIDI keyboard.

- By clicking these buttons during playback, you can apply effects to your overall performance.
  
  An effect will be applied as long as you keep the button activated.

Most of the available effects correspond to the effects that you can apply to single slices, with the green buttons corresponding to the stutter and slur effects and the red buttons to the Mute, Reverse, Staccato effects, etc. (see "Applying Slice Selection Modifiers and Slice Effects" on page 28).

Effects triggered with the Performance Controls buttons override the slice effects.

With the blue buttons and the yellow button, you can apply additional effects that cannot be applied to single slices:

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cycle 4, 2, 1</td>
<td>Temporarily sets up a short cycle over 4, 2, 1 slice, respectively. This short cycle is always set up within the loop range that is set in the ruler (see “Setting a Loop Range” on page 26). Setting up a cycle over 1 slice means that this slice is repeated until you release the button.</td>
</tr>
<tr>
<td>Continue</td>
<td>Plays back the tracks of the currently selected slices continuously until you release the button.</td>
</tr>
</tbody>
</table>

You cannot save these global effects in scenes. To apply effects and save them in scenes, you should use slice effects.

Triggering the Performance Controls With Your MIDI Keyboard

You can trigger the Performance Controls with your MIDI keyboard starting from C3 upwards. You can also make use of the Virtual Keyboard for triggering the Performance Controls (for information about the Virtual Keyboard see the Operation Manual).

Saving and Loading VST Presets

You can save all current scenes as a VST preset. Proceed as follows:

1. At the top of the LoopMash window, click the icon to the right of the Preset field and select “Save Preset” from the pop-up menu.
   
   The Save Preset dialog opens.

2. Enter a name for the new preset and click OK.
   
   The preset is saved in the User Content folder on your system. Make sure that you tag your presets for better handling in the MediaBay.
To load an existing VST preset, proceed as follows:

1. At the top of the LoopMash window, click the icon to the right of the Preset field and select “Load Preset” from the pop-up menu.
   The Presets browser opens.

2. The Presets browser shows all presets it finds in the VST 3 Presets folder for LoopMash. Double-click the preset.
   The Presets browser is closed and the preset is loaded into LoopMash.
   ▪ When a loop belonging to a preset cannot be found, LoopMash displays a standard file dialog in which you can navigate to the file.

The “Empty” preset clears all settings of the current LoopMash instance.

**Loading VST Presets Saved With a Former Version of LoopMash**

When you load a VST preset that was saved with a previous version of LoopMash, all new parameters will automatically be set to values that match the behavior of the previous LoopMash version.

⇨ To ensure MIDI control compatibility, the saved scenes are shifted to the scene pads 13-24, i.e., the scene on pad 1 is shifted to pad 13, the scene on pad 2 to pad 14, and so on.
Quantizing MIDI and Audio

Introduction

Quantizing means moving recorded audio or MIDI and positioning it on the nearest grid position that is musically relevant. Quantizing is designed to correct errors, but you can also use it in a creative way.

You can quantize audio and MIDI to a grid or to a groove. You can also quantize multiple audio tracks simultaneously.

Audio and MIDI can be quantized at the same time. However, what exactly happens during quantizing differs for audio and MIDI:

- Audio quantizing affects the audio event starts or the content of your audio, see “Quantizing Audio Event Starts” on page 34 and “AudioWarp Quantize” on page 34.

- MIDI quantizing can affect the starts of MIDI events in a part, the MIDI event lengths, or the MIDI event ends, see “Quantizing MIDI Event Starts” on page 35, “Quantizing MIDI Event Lengths” on page 35, and “Quantizing MIDI Event Ends” on page 35.

Quantizing is based on the original position of the events. Therefore, you can freely try out different quantize settings without the risk of destroying anything.

The Quantize function is found on the Edit menu. You can also use the key command [Q] or the “Quantize” button on the Quantize Panel.

Quantizing Audio Event Starts

If you select audio events or a sliced loop and use the Quantize function, the audio events are quantized based on their snap points or event starts.

The snap points that do not match exact note positions on the selected grid are moved to the closest grid positions. The grid is set up on the Quantize pop-up menu.

If no snap points are available, the event start is moved.

If you use the Quantize function on an audio part, the event starts inside the part are quantized.

AudioWarp Quantize

If you want to quantize the content of your audio event by applying time stretch, use the “AudioWarp Quantize” function. This function quantizes the audio event by aligning the warp tabs to the defined quantize grid.

The following happens:

- Warp tabs are created at hitpoint positions. If no hitpoints are available, they are automatically created. Furthermore, warp tabs are created at every event start and end.
- The audio sections between the warp tabs are stretched or compressed to fit into the time interval set up on the “Quantize Presets” pop-up menu.
AudioWarp quantize prevents warp tabs from ending up on the same position. If conflicts occur, only one of the warp tabs is quantized. For example, if you use a quantize value of 1/4 on audio that is based on sixteenth notes, the warp tabs at the quarter-note positions are quantized to the grid, and the remaining warp tabs are moved, keeping the relative distances between the warp tabs.

You can also apply AudioWarp quantizing to selection ranges in the Project window and in the Sample Editor. To avoid moving transient positions that lie outside the selection range, additional warp tabs are created at the closest hitpoint positions outside the range.

**Applying AudioWarp Quantizing**

1. Select the audio event that you want to quantize.
2. On the toolbar, activate the “AudioWarp Quantize” button, open the “Quantize Presets” pop-up menu, and select a preset to determine the quantize grid.
3. Open the Edit menu, and select Quantize.

You can also use the Quantize Panel for applying AudioWarp quantizing. The Quantize Panel provides more parameters for defining the quantize grid, see “The Quantize Panel” on page 36.

**Quantizing MIDI Event Starts**

If you select MIDI notes in a part and use the Quantize function on the Edit menu, the MIDI note starts are quantized, that is, the starts of MIDI notes that do not match exact note positions are moved to the closest grid positions. The grid is set up on the Quantize pop-up menu. The note lengths are maintained.

* If you quantize MIDI parts, all events are quantized, even if none is selected.

**Quantizing MIDI Event Lengths**

The “Quantize MIDI Event Lengths” function on the Edit menu, Advanced Quantize submenu, quantizes the lengths of MIDI notes without changing their start positions. At its most basic level, this function sets the lengths of the notes to the Length Quantize value on the MIDI editor toolbar by cutting off the note ends.

However, if you have selected the “Quantize Link” option on the “Length Quantize” pop-up menu, the function resizes the notes according to the quantize grid, taking the Swing, Tuplet, and Catch Range settings into account.

**Quantizing MIDI Event Ends**

The “Quantize MIDI Event Ends” function on the Edit menu, Advanced Quantize submenu, moves the ends of your MIDI notes to the nearest grid positions, taking the Quantize pop-up menu setting into account.

**Quantizing Multiple Audio Tracks**

You can quantize multiple audio tracks at the same time. To maintain phase coherence, all tracks have to be sliced at exactly the same start and end positions. Only then the resulting slices can be quantized without risk of getting phase errors.

* For this to work, the audio tracks must reside in the same folder track and the “=” button for Group Editing must be activated. Furthermore, at least one of the tracks must contain hitpoints.
Proceed as follows:
1. Create an edit group for the audio tracks that you want to quantize.
2. In the Sample Editor, create hitpoints for at least one of the audio tracks that you want to quantize, and fine-tune the hitpoint detection result with the Threshold slider.
3. Open the Quantize Panel.
4. Set up the parameters in the “Slice Rules” section and click the Slice button.
5. Set up the parameters in the Quantize section and click the Quantize button.
6. Set up the parameters in the Crossfades section and click the Crossfade button to correct for overlaps or gaps in the quantized audio.

AudioWarp Quantizing Multiple Audio Tracks

Instead of slicing the audio events and using the slices for quantizing, you can use warp tabs for quantizing multiple audio tracks. Note that AudioWarp quantizing does not maintain phase coherence.

To quantize multiple audio tracks using the AudioWarp quantize function, proceed as follows:
1. Create an edit group for the audio tracks that you want to quantize.
2. In the Sample Editor, create hitpoints for at least one of the audio tracks that you want to quantize, and fine-tune the hitpoint detection result with the Threshold slider.
3. Open the Quantize Panel, activate the “AudioWarp Quantize” button, and set up the parameters in the “Warp Tab Creation Rules” section.
4. Click the Create button.
5. Set up the other parameters on the Quantize Panel, and click the Quantize button. AudioWarp quantizing is applied to all tracks in the edit group.

The Quantize Panel

The Quantize Panel provides further parameters for defining how to quantize audio or MIDI. These parameters allow you to set up a more sophisticated quantization.

Using the Quantize Panel, you can quantize audio or MIDI to the grid or to a groove. Depending on what method you choose, different parameters are shown on the Quantize Panel. There is also a set of common settings.

You can open the Quantize Panel by clicking the corresponding button on the toolbar or by opening the Edit menu and selecting “Quantize Panel”.

![Quantize Panel Image]
Common Settings

Quantize Presets Pop-Up Menu
On this pop-up menu, you can select a quantize or a groove preset.

Save/Remove Preset
The preset controls allow you to store the current settings as a preset, making them available on all “Quantize Presets” pop-up menus. This includes Swing, “Catch Range”, etc.

- To save a preset, click the “Save Preset” button (the plus sign) to the right of the Quantize Presets pop-up menu.
  A preset name is generated automatically, according to your settings.
- To rename a preset, open the “Quantize Presets” pop-up menu, select “Rename Preset” and enter the new name in the dialog that appears.
- To remove a user preset, select it and click the “Remove Preset” button.

Non-Quantize
This setting allows you to create a safe zone before and after the quantize positions, by specifying a “distance” in ticks (120 ticks = one 16th note). Events that lie within this zone are not quantized. This allows you to keep slight variations when you quantize, but correct notes that are too far away from the grid positions.

Grid Display
In the middle of the Quantize Panel the grid display is shown. The green lines indicate the quantize grid, that is, the positions that audio or MIDI is moved to.

Randomize
This setting allows you to set a distance in ticks, so that your audio or MIDI is quantized to random positions within the specified distance from the quantize grid. This allows for slight variations and, at the same time, prevents your audio or MIDI from ending up too far away from the grid.

MIDI CC
If you activate this button, controllers related to MIDI notes (pitchbend, etc.) are automatically moved with the notes when these are quantized.

Auto Apply
If you activate this button, any changes you make are immediately applied to the selected parts or events. A way of using this feature is to set up a playback loop and adjust the settings until you are satisfied with the result.

iQ Mode and Iterative Strength Setting
If you quantize your audio or MIDI with the “iQ Mode” (iterative quantize) option activated, a “loose” quantization is applied. This means that your audio or MIDI moves only part of the way to the closest quantize grid position. You can specify an “Iterative Strength” value to the right of the “iQ Mode” option. This value determines how close your audio or MIDI moves towards the grid.

- Iterative quantizing is based on the current, quantized positions and not on the original event positions. This makes it possible to repeatedly use iterative Quantize, gradually moving your audio or MIDI closer to the quantize grid until you have found the right timing.
Reset Quantize
This button is identical with the “Reset Quantize” function on the Edit menu, see “Reset Quantize” on page 42.

⚠️ If you move an audio event manually, the actual event start changes. Therefore, the “Reset Quantize” function has no effect on an event that was moved manually.

Quantize
Clicking this button applies your settings.

Options For Quantizing to a Musical Grid

Grid
On this pop-up menu you can determine the basic value for the quantize grid.

Swing
This parameter lets you offset every second position in the grid, creating a swing or shuffle feel.
This setting is only available when a straight value is selected for the grid and Tuplet is off (see below).

Catch Range
This parameter allows you to specify that quantizing affects only audio or MIDI within a certain distance from the grid lines, the so-called catch range. This allows for complex quantization tasks, for example, if you want to quantize only the heavy beats near each beat, and not the events in-between.
With a value of 0%, all audio or MIDI is affected by quantizing. With higher percentages, wider catch ranges are shown around the green lines in the grid display.

Tuplet
This parameter allows you to create rhythmically more complex grids by dividing the grid into smaller steps, and thereby creating n-tuplets.
Options for Quantizing to a Groove

Groove quantizing is intended for recreating existing rhythmic feels by matching your recorded music to a timing grid generated from a MIDI part or an audio loop.

To extract the groove from a MIDI part, from an audio loop, an audio event with hitpoints, or sliced audio, select the material and drag it onto the grid display in the middle of the Quantize Panel. Alternatively, you can use the “Create Groove Quantize Preset” function, see “Creating Groove Quantize Presets” on page 42.

Position

This parameter lets you determine how much the timing of the groove affects the music. 0% means that the timing of the music remains unaffected, while 100% means that the timing is adjusted to match the groove completely.

Velocity (MIDI only)

This parameter lets you determine how much the velocity values within the groove affect the music. Note that not all grooves contain velocity information.

Length (MIDI only)

This parameter lets you specify how much the length of the notes is affected by the groove. This is done by modifying the note-off value.

For drums, the Length setting is ignored as drum sounds cannot be sustained.

Pre-Quantize

This pop-up menu lets you quantize your audio or MIDI to a musical grid before groove quantizing. This helps you to get the notes closer to their groove destination.

For example, if you apply a shuffle groove to a 16th-note pattern, you can set up a Pre-Quantize value of 16 to straighten up the timing before applying the groove quantizing.

Max. Move

Here, you can select a note value to specify a maximum distance that the audio or MIDI is moved.

Orig. Position

If you activate this option, the selected audio or MIDI reverts to its original position on the grid when quantizing.
Options for Quantizing Multiple Audio Tracks

In the “Slice Rules” section, you determine how the audio events are sliced at the hitpoints.

**Hitpoint Tracks**

This column lists all audio tracks of your edit group that have hitpoints.

**Priority**

In this column, you can define a priority for each track. This specifies which hitpoints are used to slice your audio events. The track with the highest priority defines where the audio is sliced. The audio on all tracks is sliced at all hitpoints of this track.

If you set up the same priority for several tracks, the cutting position is defined by the track that contains the first hitpoint within the specified range. This is decided for each cutting position anew.

- Click and drag to the right or to the left to specify a priority.
  - If you drag the mouse to the far left so that no star is shown, the hitpoints on the corresponding track are not taken into account.

If the zoom factor is high enough, cutting positions are marked in the Project window by vertical lines:

- The red lines indicate the cutting positions on the main track, that is, on the track whose hitpoint defines the cutting position.
- The black lines indicate the cutting positions on all other tracks.

**Range**

Two hitpoints on different tracks are considered to mark the same beat if they are located within a certain distance from each other. The Range parameter lets you specify this distance. The following rules apply:

- If one of the tracks has a higher priority, its hitpoint is used as the cutting position.
- If the tracks have the same priority, the first hitpoint in the range is used.

**Offset**

With this parameter, you can determine an offset, allowing for slight variations of the cutting position. The Offset value determines how far before the actual hitpoint position an audio event is sliced. This is useful if you want to create crossfades at the slice positions, see “The Crossfades Section” on page 41. Furthermore, it helps to avoid cutting off signals on tracks that do not contain any hitpoints.

**Slice**

If you click the Slice button, all audio events of the edit group are sliced at exactly the same positions according to your settings. The event snap points are set to the position of the hitpoint with the highest priority.

**Reset**

Click this button to undo the slicing and restore the original state of the audio events.
The Crossfades Section

The Crossfades section becomes available after you have sliced the audio events. The functions in this section are designed to correct the overlaps or the gaps that might appear due to the re-positioning of your audio.

Clicking the Crossfade button cuts the end of the first event at the start position of the following event (in case of overlaps), and stretches the second event until it starts at the end of the previous event (in case of gaps).

In some cases, you might want to achieve seamless transitions, by applying crossfades after closing the gaps. For this purpose, use the following parameters:

- Open Crossfade Editor
  This opens the Crossfade editor, where you can specify curve kind, length, and other parameters for your crossfades.

- Nudge Crossfade Left/Right
  Clicking these buttons moves the fade area in the audio event to the left or to the right in steps of one millisecond. This is useful if the Offset value in the section “Slice Rules” was not high enough, and you want to avoid that the crossfade cuts an attack.

- Length
  With this parameter you can specify the length of the crossfade area.

Options for AudioWarp Quantizing Multiple Audio Tracks

The “Warp Tab Creation Rules” section becomes available when you activate AudioWarp quantizing for multiple audio tracks.

Priority

In this column, you can define a priority for each track. The track with the highest priority defines where the warp tabs are created.

If you set up the same priority for several tracks, the warp tab position is defined by the track that contains the first hitpoint within the specified range. This is decided for each warp tab position anew.

- Click and drag the mouse to the right or to the left to specify a priority.
  If you drag the mouse to the far left so that no star is shown, the hitpoints on the corresponding track are not taken into account.
Range

Two hitpoints on different tracks are considered to mark the same beat if they are located within a certain distance from each other. The Range parameter lets you specify this distance. The following rules apply:

- If one of the tracks has a higher priority, its hitpoint is used to create the warp tab.
- If the tracks have the same priority, the first hitpoint in the range is used.

Reset

Click this button to undo the creation of warp tabs.

Create

If you click the Create button, warp tabs are created for all the tracks.

Additional Quantizing Functions

Freezing MIDI Quantizing

The Freeze MIDI Quantize function on the Edit menu, Advanced Quantize submenu, makes the start and end positions of MIDI events permanent. This is useful in situations where you want to quantize a second time, based on the current quantized positions rather than the original positions.

Reset Quantize

This command on the Edit menu reverts your audio or MIDI to its original, unquantized state. This function is independent from the regular Undo History.

The Reset function also resets any length changes that you performed using the “Scale Length/Legato” slider.

Creating Groove Quantize Presets

To generate a groove quantize map based on hitpoints that you have created in the Sample Editor, proceed as follows:

1. Open the Sample Editor for the audio event from which you want to extract the timing.
2. Create and edit hitpoints.
3. On the Hitpoints tab, click the “Create Groove” button. The groove is extracted.

If you open the Quantize pop-up menu on the Project window toolbar, you will find an additional item at the bottom of the list, with the same name as the file from which you have extracted the groove. You can select it as a base for quantizing, just like any other quantize value.

4. To save the groove, open the Quantize Panel and store it as a preset, see “Save/Remove Preset” on page 37.